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Chapter 1
Introduction
In this chapter:

• Introduction

• How to reach us
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Chapter 1: Introduction
Introduction
This guide is intended as a reference for teachers while preparing the AutoSkill 
Academy Suite for use after the program has been installed and the System 
Administrator or AutoSkill Coordinator has entered district information, added 
schools, and distributed licenses.

Copies of the “Environment” and “Monitoring and Managing Student 
Training” chapters from the User Guide are also included, so this book can be 
used as a reference during student training.

The tasks to prepare for training include:

• Creating classes and assigning students to them.

• Familiarizing yourself with the Academy

• Preparing the classroom for students

• Introducing students to the program

All of the steps are described in Chapter 2 of this book. If you need additional 
information, references to the User Guide are provided.

Getting Started for Administrators
A second book, called Getting Started for Administrators contains the tasks 
that the System Administrator must complete before AutoSkill Coordinators or 
Teachers can complete their preparation. The book also contains the steps that 
are in this Guide, so it could be used as a complete reference for preparing the 
Academy for use. Getting Started for Administrators does not include the copy 
of “Monitoring and Managing Student Training”.
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Introduction
Introduction
The AutoSkill Academy Suite™ is a suite of intervention programs for students 
who need to develop their basic reading and math skills. It includes the 
Academy of READING®, an intervention program for students who need to 
develop their basic reading skills and the Academy of MATH®, an intervention 
program for students who need to develop their basic math skills, especially 
those who are behind.

The Academy of READING focuses on the component skills of reading, 
including sound matching, letter-sound matching, decoding, and phonics. The 
aim is to work towards developing a student’s comprehension abilities. This 
combination represents a powerful intervention tool to complement your 
existing reading curriculum for students in K-12 and adults.

The Academy of MATH focuses on ten basic math skill areas: number sense, 
addition, subtraction, multiplication, division, fractions, equations, 
measurement, geometry, and graphing. Within each area, the student learns the 
appropriate terms, uses them in operations, and solves word problems.

The Academy of READING, the Academy of MATH, and the AutoSkill 
Management System are installed on a central Academy Server Station 
computer. You use the web browser on your workstation to run the program. 
The license key, which is imported the first time the System Administrator logs 
in to the AutoSkill Management System, determines which programs and 
features are available.

Teachers and other staff use the AutoSkill Management System to control and 
monitor student training. Students use the Academy of READING or the 
Academy of MATH student interface, each of which is separate from the 
Management System, to do their work. The AutoSkill Management System 
and the student interface can be accessed locally or remotely from any 
supported client workstation web browser.
  3



Chapter 1: Introduction
Components
All of the components of the AutoSkill Academy Suite are installed on the 
Academy Server Station. They include the Academy of READING application, 
the Academy of MATH application, a database (which is used by the Academy 
of READING, the Academy of MATH, and the AutoSkill Management System), 
and a web server. The database and web server are used only by the Academy 
of READING and the Academy of MATH. They are independent of any other 
databases or web servers that may already be installed.

Students and staff use their web browsers to communicate with the Academy 
web server, which in turn communicates with the application and the database.

SuccessTrack
Reports on student training at the district, school, class, and student level are 
included with the Academy of READING and the Academy of MATH. Also 
included is SuccessTrack. This is a feature that allows administrators to set 
targets for time on task and session time.

SpanishTutor
For students whose first language is Spanish, the SpanishTutor™ add-in 
provides Spanish-language tutorial assistance and instructions. In this way, 
students can devote their attention to improving their skills, and not to figuring 
out how to use the program. The purpose of the training, however, is still to 
improve English skills, not Spanish.

How to reach us
If you have a question about the Academy or require technical assistance, you 
can contact AutoSkill International Inc. by

Telephone
Customer Support: 1-800-288-6754 
Support Hours: Monday through Friday 8:00 a.m.to 7:00 p.m. [Eastern Time]

Email
You can also send your support request to support@AutoSkill.com
4



How to reach us
Web
Visit us at www.AutoSkill.com 

Mail
AutoSkill International Inc.
555 Legget Drive, Tower B
Ottawa, ON, Canada
K2K 2X3
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Chapter 2
The Environment
In this chapter:

• Introduction

• Logging in

• The management system display

• Online and printed documentation

• Printing

• Saving reports
   7



Chapter 2: The Environment
Introduction
This chapter covers the AutoSkill Management System display. It shows:

• Logging in

• The management system display

• Online and printed documentation

• Printing

• Saving reports

Logging in
Staff and students each have their own user interface. Staff members use the 
AutoSkill Management System interface and students use the Academy of 
READING or Academy of MATH student interface.

Staff login
Teachers and other staff members use the AutoSkill Management System to 
monitor and manage student training. Staff members who have administrative 
responsibilities within the Academy also use the AutoSkill Management 
System to carry out their duties.
8



Logging in
Note: The license for the AutoSkill Academy Suite may have an expiry 
date. If the license has expired, students may continue training, but a Sys-
tem Administrator must log in to the AutoSkill Management System and 
import a new license before other staff members can log in.

Figure 2-1:  Staff member login page

To log in as a staff member
1 On your workstation, click on the AutoSkill Management System icon, or 

in your web browser enter the URL for the Management User login page. 
(http://<server name or IP address>/academy/manage-
ment.do). The AutoSkill Management System login page appears.

2 If you are a System Administrator or District Administrator, select District.
If you are an AutoSkill Coordinator, Teacher, or School Administrator, 
select your school.

3 Enter your password and click Login.
  9



Chapter 2: The Environment
Note: The most common causes of login difficulties are errors in typ-
ing or selecting a school that does not correspond to your role.

Student login
Students use the student login screen to log in to the Academy of READING or 
the Academy of MATH. Staff cannot log in from a student login screen. They 
log in from the AutoSkill Management System screen.

Figure 2-2:  Student log-in screen 

From time to time, particularly for familiarization purposes, as a staff member 
you may want to log in to the Student interface. To do this, you can create a 
student account for yourself and log in with that account.

Note: If you do not want the information from your practice student 
account to appear in any reports generated by the Academy, clear the 
Register for training boxes on the practice student’s Modify a Student 
User: Personal Information page when you finish your practice session. 
You access this page from the Classes Registry List on the Classes tab.

To log in as a student
1 Make sure that the student is wearing good quality headphones and is com-

fortably seated at the workstation.
2 On the student’s workstation, click on the Academy of READING or Acad-

emy of MATH icon or, in the web browser, enter the URL for the Student 
login page. (http://<server name or IP address>/academy/
academyofreading.do or http://<server name or IP 
address>/academy/academyofmath.do). The Student login page 
appears.

3 Select the school from the drop-down list if necessary.

10



The management system display
4 Type the student user name and password.
5 Click Login. The Academy of READING or Academy of MATH lobby 

opens.

Notes: 

• The most common causes of login difficulties are errors in typing 
or selecting the wrong school.

• Student user names are listed in the Student Registry and in the 
Class Registry. If View student passwords is selected in the 
options on the System tab, the Class Registry will also show the 
student passwords.

• You can print the Class Registry.

The management system display
The AutoSkill Management System display contains up to five tabs 
(depending on the role of the logged-in user), a menu bar on the left side, and 
an application area in which the data appears.

Figure 2-3:  Typical management interface page

Tabs on the management system display
The management system display uses up to five tabs, depending on your role. 
Menu items available depend on user role.

System tab: Used for system-wide maintenance and monitoring activities. 
Accessible by System Administrators (some functions are also accessible by 
AutoSkill Coordinators). Functions include:

Your user 
name

Menu bar 
contents 
depend on 
your role

Tabs visible according 
to your user role

Application window. Contents vary 
according to Tab and menu selection

Open help 
page for this 
screen
Open a view 
for printing

Log out
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Chapter 2: The Environment
Schools tab: Used for district and school administration activities. Menu items 
available depend on user role. Accessible by System Administrators and 
AutoSkill Coordinators. Functions include:

Classes tab: Used for managing classes, monitoring student training, viewing 
student certificates, and setting the test schedule. Information on this tab is 
updated continuously. This is the place where Teachers will spend most of their 
time when logged in to the Academy. Accessible by System Administrators, 
AutoSkill Coordinators, and Teachers. Functions include:

• Monitoring system status and activity • Recovering or purging deleted 
students

• Backing up the database • Setting system options

• Scheduling report updates • Importing or exporting student 
records

• Viewing and modifying District 
information

• Creating or deleting schools

• Transitioning to a new training period • Managing licenses

• Setting SuccessTrack parameters • Completing student transfers

• Viewing or modifying school 
information

• Viewing or modifying class 
information

• Viewing and printing student 
certificates

• Creating or deleting classes • Scheduling student tests

• Monitoring and managing student 
training
12



Online and printed documentation
Users tab: Used for managing staff and student accounts. Accessible by 
System Administrators and AutoSkill Coordinators. Functions include:

Reports tab: Used for viewing reports on student training at the student, class, 
school, and district level. Information is up to date as of the last report update 
as specified on the System tab. Accessible by System Administrators, District 
Administrators, AutoSkill Coordinators, School Administrators, and Teachers. 
Reports include:

Online and printed documentation
The user documentation is accessible from the AutoSkill Management System. 
It consists of context-sensitive help, online documentation, and documentation 
in PDF format, which you can print locally.

Note: To view the online help, JavaScript must be enabled in the browser. 
In Internet Explorer, browser security settings must allow active script-
ing. 

• Viewing or modifying staff and 
student information

• Changing passwords

• Creating or deleting staff and student 
user accounts

• Viewing student status warnings

• Snapshot reports • Gains details

• Test results • Gains summary

• Student training progress • Reading comprehension

• Class weekly progress • Math training details
  13



Chapter 2: The Environment
The documentation available is listed below:

• Context-sensitive help: Context-sensitive help explains the information 
on the page that you are viewing. To open the context-sensitive help, click 
the Help link at the top of any page in the browser.
For additional information, and to help place the information in context, 
you can refer to the Table of Contents in the left-hand pane of the window. 
To quickly display the current location in the Table of Contents, click the 

 icon.
To access documents in PDF format, click on the Printed Documentation 
link. These files can be viewed and printed in Adobe® Reader®, a free 
download available from www.adobe.com.

• Installation Guide: The Installation Guide provides the information 
required to prepare to install the Academy, carry out the installation, and to 
verify that the installation is successful. The document is available as a 
printed book as a PDF file on the installation CD.

• Getting Started Guide for Administrators: Getting Started Guide for 
Administrators provides System Administrators with condensed instruc-
tions for preparing the AutoSkill Academy Suite for use after it has been 
installed. Some of the student- and class-related procedures can also be car-
ried out by AutoSkill Coordinators or Teachers. The document is available 
as a published book, and online as a printable PDF file.

• Getting Started for Teachers: The Getting Started Guide for Teachers 
provides AutoSkill Coordinators and Teachers with condensed instructions 
for setting up classes and preparing the Academy of READING and the 
Academy of MATH for use. The document is available as a published book, 
and online as a printable PDF file.

• User Guide: The User Guide contains detailed instructions for setting up 
and managing the Academy of READING and the Academy of MATH, mon-
14



Printing
itoring student training, and completing system administration tasks. It is 
available online as a printable PDF file.

• Reports Guide: The Reports Guide describes each of the training reports 
created by the Academy of READING and the Academy of MATH. It is 
available online as a printable PDF file.

• Math Placement Test Questions: The Math Placement Test Questions 
book contains the questions and answers used in the Academy of MATH 
pre-test and post-test. It is available online as a printable PDF file.

• Reading Placement Test Questions: The Reading Placement Test Ques-
tions book contains the stories, questions, and answers used in the Academy 
of READING tests. It is available online as a printable PDF file.

• Reading Comprehension Training Stories: The Reading Comprehen-
sion Training Stories book contains the stories and questions used during 
comprehension training. It is available online as a printable PDF file.

Printing
You can print any page in the Management System that has a Printer Friendly 
link ( ). Click the link to open a new window with a view that is 
suitable for printing. Use the Print command in your browser to print the view. 
Close the window to return to the Management System.

Most web browsers allow you to control the page layout and printing of 
background colors and images. Page layout includes margins, orientation, 
headers, and footers.

For the Academy screens to print as they should, you should set the browser to 
print the background colors and images.

Setting the print options in Internet Explorer
In Internet Explorer, you use the File menu to set the page layout, and the 
Advanced tab in Internet Options on the Tools menu to control the printing of 
background colors and images.

To set page layout and print options in Internet Explorer
1 In the File menu, select Page Setup. The Page Setup screen appears.
  15



Chapter 2: The Environment
Figure 2-4: Page setup - Internet Explorer

2 Set the options as required and then click OK.
3 On the Tools menu, select Internet options and then select the Advanced 

tab.

Figure 2-5: Internet options

4 On the Settings screen, scroll down to the Print section and select Print 
background colors and images. This is required to ensure that all of the 
information on the screen is printed.

5 Click OK.

Set the page margins

Specify the information you want in the headers 
and footers. Use the ‘?’ (context-sensitive help) 
for information about the symbols to use

Click OK when done

Select ‘Print background colors 
and images’. This is required to 
ensure that all of the information 
on the screen is printed.
16



Printing
Setting the print options in Netscape
In Netscape, you use the File menu to set the page layout and to control the 
printing of background colors and images.

To set page layout and print options in Netscape
1 In the File menu, select Page Setup. The Page Setup window appears.

Figure 2-6: Page setup - Netscape

2 On the Format & Options tab, select Print Background (colors & 
images). This is required to ensure that all of the information on the screen 
is printed.

3 Select the Margins & Header/Footer tab.

Figure 2-7: Headers and footers

4 Set the options as required and then click OK.

Select Print Background (colors 
and images). This is required to 
ensure that all of the information 
on the screen is printed.

Set the page margins

Specify the information you want in 
the headers and footers

Click OK when done
  17



Chapter 2: The Environment
Setting the print options in Firefox
In Firefox, you use the File menu to set the page layout and to control the 
printing of background colors and images.

To set page layout and print options in Firefox
1 In the File menu, select Page Setup. The Page Setup window appears.

Figure 2-8: Page setup - Firefox

2 On the Format & Options tab, select Print Background (colors & 
images).

3 Select the Margins & Header/Footer tab.

Figure 2-9: Headers and footers

4 Set the options as required and then click OK.

Select Print Background (colors 
and images). This is required to 
ensure that all of the information 
on the screen is printed.

Set the page margins

Specify the information you want in 
the headers and footers
18



Printing
Setting the print options in Opera
In Opera, you use the File menu to set the page layout and to control the 
printing of background colors and images.

To set page layout and print options in Opera
1 In the File menu, select Print options. The Print Options window appears.

Figure 2-10: Print setup - Opera

2 Select Print page background. This is required to ensure that all of the 
information on the screen is printed.

3 Select the other options as needed.
4 Click OK.

Setting the print options in Safari
In Safari, you use the File menu to set the page attributes. Then, you click Print 
and select the printer to use and set other print options, such as printing 
backgrounds, on the Copies & Pages pop-up menu.

To set page layout and print options in Safari
1 In the File menu, select Page Setup. The Page Setup window appears.

Required for printing all of the information 
that is on the screen

Set the page margins

Puts the entire width of the print out on the 
paper.

Header and footer information can be printed 
but not changed in Opera
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Chapter 2: The Environment
Figure 2-11: Page setup - Safari

2 Set the options and then click OK.

Note: To save the settings for future use, first select Save as Default 
from the Setting menu.

3 From the browser File menu, click Print. A printer selection screen opens.

Figure 2-12: Printer settings

Select the paper size, 
orientation, and scale

To save the options for future 
use, first select Save as Default 
from the Setting menu.

Select Safari 
from the pop-
up menu

To keep the settings, select Save As... 
from the Presets menu

Select Print Backgrounds
20



Saving reports
4 From the Copies & Pages menu, select Safari and select Print back-
grounds. This is required to ensure that all of the information on the screen 
is printed.

5 To save the presets for future use, select Save As... from the Presets menu.

Saving reports
All reports on the Reports tab have a Save link ( ). Clicking this link 
creates an Adobe PDF file on the Academy Server Station and then opens the 
browser download dialog so that you can save the file.

You can open the file without first saving it. If you do this, be sure to save the 
file before you close the viewer; otherwise, you will again have to click Save 
in the Reports tab.

To save a report
1 On the Reports tab, display the report to be printed.
2 Click Save at the top of the report. A PDF file is created on the Academy 

Server Station, and a new web browser window opens, with the file down-
load dialog displayed. The dialog for Microsoft Internet Explorer is shown 
in the figure.
To cancel the export, click Cancel.

Figure 2-13: File download

3 You can either save the file or you can open it.
Click Save to save the file in a suitable location.
To open the file, click Open. (If you choose to open the file instead of sav-
ing it, the file is no longer available from within the Academy. You must 
save it from the program you used to open it.)
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Chapter 2: The Environment
Note: In the Safari browser on the Macintosh, the file opens in a pre-
view window and is automatically saved to the default location speci-
fied in the Safari download preferences.
22



Chapter 3
Quick Start
In this chapter:

• Overview

• Log in to the AutoSkill Management System

• Create classes and add students to them

• Familiarize yourself with the Academy

• Prepare the classroom

• Introduce students to the program
   23



Chapter 3: Quick Start
Overview
This chapter summarizes what to do to prepare the program for use after it has 
been installed and schools and students have been added to the registry list.

Each step is discussed in more detail in a corresponding section later in the 
chapter.

1 Log in to the AutoSkill Management System, page page 24.
2 Create classes and add students to them, page 24.
3 Familiarize yourself with the Academy, if you wish to familiarize yourself 

with the students’ view of the Academy, page 30.
4 Prepare the classroom, page 31.

Log in to the AutoSkill Management System
Log into the AutoSkill Management System with your user name and 
password.

If staff members have not yet been added to the Academy, you will have to log 
in using the System Administrator account that was set up during the 
installation. Then, you can add the staff members who will complete the rest of 
the tasks.

Create classes and add students to them
You can do this as one step per class, or you can create the classes and then let 
each teacher add the students to their own classes.

You create classes or modify class information on the Classes tab.

For more information, see “Creating, modifying, or deleting classes” in the 
User Guide under “Managing Classes”.

To create a class
1 Click on the Classes tab.
24



Create classes and add students to them
2 On the Classes menu, click Create a class. The Create a Class: Class 
Information page appears.
Figure 3-1: Class information

3 Add the class information as described below.

Table 3-1: Class information 

Field Description

School
System Administrators can select a school; AutoSkill 
Coordinators and Teachers can see only their own school.

You cannot change the school that an existing class belongs to.

Teacher 
(owner)

This is the teacher who has primary responsibility for the class.

System Administrators and AutoSkill Coordinators can select 
from a drop-down list that contains all of the teachers registered in 
the school. Classes created by a Teacher automatically belong to 
that teacher.

Teachers cannot assign a class to a different teacher.

Teacher 
(secondary)

These are teachers other than the primary teacher who also have 
responsibilities in the class.

Grade Students in the class can be from a different grade than the one 
assigned to the class.
  25



Chapter 3: Quick Start
4 To save the class without adding students, click Save. 

Note: To cancel without saving any changes, click any menu item in 
the navigation pane.

To add students to the class, click Save and add students to this class. The 
Select Students to Add to this Class page appears. See “Add students to a 
class”.

Add students to a class
You use the Classes tab to add students to a class.

Teachers can add students to their own classes only. System Administrators 
and AutoSkill Coordinators can add students to any class.

For more information, see “Creating, modifying, or deleting classes” in the 
User Guide under “Managing Classes”.

To add students to a class
1 Click on the Classes tab.

Subject Reading or Math. Available choices depend on which products are 
installed and licensed.

Name

Must be unique within Reading or within Math. You can have the 
same name for a Math class and a Reading class.

You can use letters, numbers, spaces, ampersand (&), apostrophe 
(’), quote (”), period (.), hyphen (-), forward slash (/). Maximum 
length is 30 characters.

The system automatically creates a name consisting of the 
teacher’s name and a letter or number representing the class grade, 
but you can change it.

Comments Maximum length is 255 characters.

Table 3-1: Class information  (Continued)

Field Description
26



Add students to a class
2 On the Classes menu, click Registry list. The Class Registry List page 
appears.

3 Click on a class name. The Class Information page for the class appears.

Note: If you are a teacher and your name does not appear in the Teacher 
column, no classes have been assigned to you. You must create a class 
before you can add students.

To add students to the class, click Add students to this class. The Select 
Students to Add to this Class page appears.
Figure 3-2: Add students to a class

4 Select the checkbox beside each student who is to be added to the class. If 
you wish, you can use the Grade list to display only students who are in a 
certain grade.
If a student’s name is not on the list, you must add the student to the regis-
try first. See “Creating a student to add to a class”

Note: To cancel without saving any changes, click Cancel or click any 
menu item in the navigation pane. Any new students you registered in 
the Academy will remain, however.

5 Click Add to class. The selected students are added to the class and the 
Review Class Roster page appears.
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Chapter 3: Quick Start
Creating a student to add to a class
If a student who you want to add to a class does not appear on the student list, 
you can add the student to the registry list and then add the student to the class.

To create a student
1 On the Select Students to Add to this Class page, click Create a new stu-

dent.
2 For a new student, on the Students menu click Create a student. The Cre-

ate a Student User: Personal Information page appears.
3 Enter the information as described below.

Table 3-2: Student personal information 

Field Description

Grade The grade the student is in within the school system. 
Select from the list.

Last name
Middle name
First name

Names can contain letters, numbers, spaces, 
ampersand (&), apostrophe (’), quote (”), period (.), 
hyphen (-). Maximum length is 30 characters.

User name

Change the user name if you want.

Not case-sensitive. You can use letters, numbers, 
spaces, ampersand (&), apostrophe (’), quote (”), 
period (.), hyphen (-), underscore (_), at sign (@). 
Maximum length is 30 characters.

Password
Confirm password

Not case-sensitive. Use any character. Spaces are not 
allowed. Maximum length is 30 characters.

Birth date
Select the month, day, and year of birth from the 
drop-down lists. If you do not want to specify a year, 
select ‘Adult’. To omit the birthday, select mmm/dd/
yyyy.

Gender Use ‘Unknown’ if you do not want to specify the 
gender.
28



Add students to a class
Student number

Not required but if used it must be unique within the 
district.

Case-sensitive. Use letters and numbers only. 
Maximum length is 30 characters.

Training information

Select Academy of READING and/or Academy of 
MATH to register the student for training.

Students must be registered in the Academy of 
READING, the Academy of MATH, or both before 
they can start training. Only selections for items that 
are installed and licensed are available.

Academy of READING

• Assign junior/senior story topics: By default, 
junior story topics are assigned to grades K-8.

• Enable SpanishTutor: Select for students who are 
to receive tutorial assistance and instruction in 
Spanish. Available only if the SpanishTutor 
module has been activated.

• Do not test this student: The student will receive 
neither a placement test nor any post-tests. You 
cannot change this option after the student has 
logged in for the first time.

Table 3-2: Student personal information  (Continued)

Field Description
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Chapter 3: Quick Start
4 Click Save.
The student is added to the registry and the Select Students to Add to This 
Class page appears again.

Note: To cancel without saving any changes, click Cancel or click any 
menu item in the navigation pane.

Familiarize yourself with the Academy
If you want familiarize yourself with the Academy, you can create and use a 
couple of practice student accounts to see how the training works. After you 
have finished with these accounts, you should delete them or at the very least 
remove their registration for training. Click on the student name in the Students 
Registry list and under Training information remove the checkmark from 
Academy of READING and Academy of MATH.

Academy of MATH

• Read math questions automatically: Questions 
and response options are read aloud to the student. 
After the passage is read, the student can click on a 
passage and hear again. This is the default for 
grades K-1.

• Enable read-aloud for math questions: Student 
can click on a text passage to hear it read out loud.

• Disable read-aloud for math questions: Read-
aloud is not available.

• Enable timer bar on the math question screen: 
Show time remaining to answer a question. Applies 
to training only, not to placement test or practice 
questions.

• Enable SpanishTutor: Select for students who are 
to receive tutorial assistance and instruction in 
Spanish. Available only if the SpanishTutor 
module has been activated.

Table 3-2: Student personal information  (Continued)

Field Description
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Prepare the classroom
Prepare the classroom
Before your students come to class, prepare the classroom for use. Some things 
to consider:

• Ensure that each of the workstations that students are to use are working 
properly and that the student login page displays properly.

• Ensure that each workstation is equipped with a proper set of earphones for 
the student.

• Log on to the AutoSkill Management System, display the class list for your 
class and print a copy. You will use the list to help students with logging in 
to the Academy.

Before students begin training, it is advised that you print out the class roster 
that lists the user name and passwords of students. However, this roster must 
be kept in a secure location and students must not have access to this roster. It 
is to be used for reference by the teacher only.

Introduce students to the program
Students who have not been exposed to the program before will benefit from 
some assistance in starting.

Logging in as a student
1 Have students locate the Academy of MATH or Academy of READING icon 

that appears as a shortcut on the student workstation desktop.
If you do not have this icon, you can also start the program by entering one 
of the following URLs in your web browser:
For the Academy of READING - http://<your server name>/
academy/academyofreading.do

For Academy of MATH - http://<your server name>/academy/
academyofmath.do.

2 Select the school from the drop-down list.
3 Enter the student user name in the Student User Name field.
4 In the Password field, enter the student’s password.
5 Click the Login button.
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Chapter 3: Quick Start
6 Have students explore the student lobby.
7 When the students are ready, they can click on the classroom door and 

begin the placement test.

Tips for doing placement tests
Students who are mentally prepared do better in tests:

• Try not to test at the end of a day or week or when students are tired. Test-
ing near holidays or other fun activities can result in weak attention to the 
task and results in poor outcomes.

• Students need to be in a good frame of mind. If students are having a bad 
day, their scores will reflect this.

For all tests:

• Allow at least a full class period for the test. Some students will require 
more than one period. Tell the students that the test may take some time.

• During the test, monitor students early to ensure they understand and are 
participating. Tell them not to rush. Time is not a factor; however, you 
should note the time that each student takes. Watch for students who are 
going through the assessment too quickly.

• Some younger students may not understand how to use the mouse at first. 
You will have to show them.

• Have students check their work, ensuring that they did not miss any ques-
tions.

In the Academy of READING:

• Have students read the entire passage silently before answering any ques-
tions. More than one response may appear to be usable, so tell the student 
to select the response that they think most closely fits the story.

• The I'm Done button appears when the student has completed a story. If the 
button does not appear, the student has probably not answered all of the 
questions. Look for empty blanks in the story.

In the Academy of MATH
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Introduce students to the program
• Tell the student not to worry if the questions appear too difficult. In order to 
find the correct level, the program must ask questions that are beyond the 
student's ability.

• The I'm Done button appears when the student has answered all ten of the 
questions in the current level. If the button does not appear, the student has 
probably not answered all of the questions. Look for a 'blue button' in the 
list of question numbers.
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Chapter 4
Monitoring and Managing 
Student Training
In this chapter:

• Introduction to monitoring student training

• Training monitor

• Student training progress

• Progress in Individualized Training Program

• Interventions in training

• Modifying mastery criteria

• Modifying the assigned training program

• Certificates

• Student Testing

• Student finishes a training program
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Chapter 4: Monitoring and Managing Student Training
Introduction to monitoring student training
The purpose of monitoring student training is to stay informed about their 
progress so that you can identify developing problems early and give the 
students the help they need.

The Classes tab gives you access to the information and tools to monitor 
training. You can view and monitor progress at the class level and at the 
individual student level. Teachers have access to their own classes, AutoSkill 
Coordinators have access to all classes in their school, and System 
Administrators have access to all classes in all schools.

When you click on the Classes tab, the Training monitor page opens. This page 
lists all of the students in a class and gives a quick visual impression of their 
progress. You can choose to see classes from the Academy of READING or the 
Academy of MATH. Information accessed from the Training monitor page is 
kept up to date at all times. By contrast, the information on the Reports tab is 
updated at intervals specified by the System Administrator. It could be up to 24 
hours old.

While managing student training, you can:

• View a list that shows the current status of all students’ training.

• View a summary of a single student’s training in the current exercise.

• View the student’s progress in the Individualized Training Program.

• Modify the mastery criteria for skills.

• View and print student training certificates.

• View testing status and specify when students take post-tests.

Training monitor
The Training Monitor page is the home page for Teachers, and is the page that 
appears when a System Administrator or AutoSkill Coordinator clicks on the 
Classes tab. It gives an overview of the recent activity in the selected class, 
showing the last time students logged in, what skills they are working on, and 
an indication of how they are progressing.
36



Training monitor
Figure 4-1:  Training monitor (Academy of READING/Academy of MATH)

Viewing the class training monitor
This page opens by default when you click on the Classes tab. From any other 
page on the Classes tab, you click on the Training Monitor menu selection to 
open the page. You can view the students in any class that you have access to. 
By clicking on any student’s name, you can see a detailed summary of the 
student’s training. 

Class training monitor
This page lists the students who are in the selected class. It shows when they 
last logged in to the program and their progress in the skill that they are 
working on.

At the top of the page, select Academy of READING or Academy of MATH.

Select a School from the list. System Administrators can select a school. 
AutoSkill Coordinators and Teachers can see only their own school.

Academy of READING

Academy of MATH
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Select a Class from the list. System Administrators and AutoSkill Coordinators 
can select any class in the school. Teachers can select only their own classes.

The Next Scheduled Test Date serves as a reminder that one or more students 
is to receive a test on the date indicated. Click Test Schedules on the Class 
Tools menu to see which students are affected.

Table 4-1: Training monitor

Field Description

Student 
name

Click on the student name to view the Student Training Progress for 
that student.

Last login The date the student last logged in.

Current 
skill

The skill area and skill that the student is working on.

In the Academy of READING, students train in five skill areas: Each 
skill area consists of several skills.

• Sound Match
• Letter-Sound Match

• Visual Match
• Auditory-Visual Match
• Comprehension

In the Academy of MATH, students train in ten skill areas: Each skill 
area consists of several skills.

• Number sense
• Addition
• Subtraction
• Multiplication
• Division

• Fractions
• Equations
• Measurement
• Geometry
• Graphing

Trial 
number

Trial type and number:

• P—Practice
• T—Training
Numbers are sequential from the first trial, regardless of the trial type. 
For example: P1, T2, T3, T4, P5, P6, T7, etc.
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Training monitor
Progress Student has completed all training and has a status of Graduate.

Student is progressing well and has had no interventions for the 
current skill type.

At least one intervention has occurred for the current skill type.

In the Academy of READING, student has been paused in AVM 
or VM and is working on the next skill in sequence other than 
the one they are paused in.

In the Academy of MATH, student has been paused in any skill 
and is working on a skill at the next lower level.

In the Academy of READING, student has been paused in AVM 
or VM. The student is working on the next skill in sequence 
other than the one they are paused in. The student has had at 
least one intervention in that skill.

In the Academy of MATH, student has been paused in any skill 
and is working on a skill at the next lower level. The student 
has had at least one intervention in that skill.

Student needs teacher time.

In the Academy of READING, student has been paused in AVM 
or VM. The student is working on the next skill in sequence 
other than the one they are paused in and needs teacher time on 
that skill.

In the Academy of MATH, student has been paused in any skill 
and is working on a skill at the next lower level. The student 
needs teacher time on that skill.

Table 4-1: Training monitor

Field Description
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Student training progress
The purpose of this page is to give the teacher information about a student’s 
progress on current skill. This page gives the information needed to allow the 
teacher to understand what can be done to help the student.

Figure 4-2:  Student training progress page (Academy of READING/Academy of MATH)

The information provided includes:

• The name of the Individualized Training Program that the student is fol-
lowing. You can click on the program name to get more details.

• The name of the skill the student is working on and a summary of the stu-
dent’s progress. You can click on a link to show details of the student’s 
practice on the skill.

• A button to clear teacher time for the student.

Academy of READING

Academy of MATH
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Student training progress
• Links to the mastery criteria pages.

• In the Academy of MATH, a link to change the student’s Individualized 
Training Program.

Viewing student training progress
You open the Student Training Progress page for the student’s current skill by 
clicking on the student’s name on the Training Monitor page. From there, you 
can open a page that shows details of the student’s progress.

To view the student training summary
1 On the Class Training Monitor page, select Academy of READING or 

Academy of MATH, and then select a school and class.
2 Click the student’s name. The Student Training Progress page for the cur-

rent skill appears.
3 From this page you can view other information about the student’s training:

4 Click OK to return to the Class Training Monitor page.

To view: Do this:

The student’s Individualized Training 
Program

Click the underlined program name 
beside the Training program label. 
The Student Progress From <Date> To 
<Date> page appears. See “Student 
progress from <date> to <date>” on 
page 49.

Details of the student’s work on the 
current skill

Click the Show trial details link. This 
link is not available while viewing 
tutorials. See “Student training 
progress” on page 42.
  41



Chapter 4: Monitoring and Managing Student Training
Student training progress
The top portion of the page shows administrative information about the student 
and indicates which Individualized Training Program the student is following. 
Click on the link to view the entire training program and the student’s progress.

Notes: 

• An asterisk (*) in front of the training program name indicates that 
the student has completed the initial Individualized Training Pro-
gram and is working on supplemental material. Also, in the Academy 
of MATH only, the asterisk will appear if a teacher has manually 
changed the student’s assigned Individualized Training Program.

• A plus-sign (+) after the training program name indicates that some 
skills from the previous training program were not mastered at the 
Academy Recommended criteria and have been added to the current 
training program.

• A period followed by a number (for example, “.2”) after the training 
program name indicates that the same training program has been 
assigned previously in the current training period or in a previous 
training period.

The shaded portion of the page gives information about the student’s progress 
on the current skill area.

Click on the Show Trial Details link to change the display in the bottom 
portion of the page to show detailed information about each of the trials the 
student has attempted.

The Interventions portion of the page shows the last intervention that occurred 
and the actions taken.

If a student’s training is paused and the student is in teacher time, a 
Recommendation section appears with suggestions about actions to take before 
clearing teacher time. To cancel teacher time and allow the student to carry on 
with training, the teacher clicks the Clear teacher time button. This button is 
available only if the student’s training is currently in Teacher time.
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Student training progress
If a student is struggling, the Academy can temporarily adjust the mastery 
criteria for one or more exercises. It is also possible for staff to change the 
criteria, although this should be done only in special circumstances. Links at 
the bottom of the page provide access to the forms for doing that. See 
“Modifying mastery criteria” on page 57 for more information about changing 
mastery criteria.

In the Academy of MATH, if the teacher thinks that the training program 
assigned may not be suitable for the student (either too easy or too hard) the 
program can be changed. See“Modifying the assigned training program” on 
page 67 for more information.

Clicking OK opens the Student training progress page.

Student training progress—Trial details
When the student clicks on the Show Trial Details link, the lower portion of the 
Student Training Progress page changes to a list of all of the trials the student 
has attempted for the current skill. It shows when the trials were attempted and 
the results on each. A link is provided to show details of the errors on each 
trial.

Table 4-2: Mastery criteria modification

Link Description

Modify mastery 
criteria for 
<current skill>

Opens a page where you can change the mastery criteria for the 
specific skill area the student is working on.

Modify mastery 
criteria for the 
entire skill area

Opens a page where you can select a skill area and modify the 
mastery criteria for the entire skill area.
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Figure 4-3:  Student training progress—Trial Details (Academy of READING/Academy of MATH)

Click OK to return to the Training progress page.

Table 4-3: Student training progress—Trial details

Field Description

Trial

Trial type and number, most recent at the top:

• P—Practice
• T—Training
Numbers are sequential from the first trial, regardless of the trial 
type. For example: P1, T2, T3, T4, P5, P6, T7, etc.

Start date Date the student started the trial.

Time on trial Time spent working on the trial.

Correct answers The number of correct answers out of the total questions in the 
trial.

Errors The number of errors made. Click on an entry to show the Trial 
errors—details page.

Time-outs The number of times the student failed to answer in the allotted 
time.

Pace
In the Academy of READING, the difference between the 
slowest and fastest response time in AVM or VM exercises. 
Also known as the response time range.

Academy of READING

Academy of MATH
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Student training progress
Trial errors—details (Academy of READING)
For each error in the selected trial, this page shows the expected response and 
the student’s actual response. For those exercises that allow two attempts and 
selecting the correct answer, the page lists both errors.

For Comprehension exercises, each question that the student answered 
incorrectly is shown.

Figure 4-4:  Student training progress—Trial errors (Academy of READING)

Table 4-4: Details of errors in trials

Link Description

Target Shows what the expected response was.

First 
error The student’s response. 

Second 
error

For puzzles (where the student is allowed two tries to select the correct 
response), this column shows the student’s second incorrect response.

Question In Comprehension exercises, the question the student answered 
incorrectly.

Typical error summary for exercises 
other than Comprehension

Typical error 
summary for 
Comprehension 
exercises, showing 
question and 
question type
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Click OK to return to the Training details view.

Trial errors—details (Academy of MATH)
For each error in the selected trial, this page groups errors by learning 
objective and for each question shows the number of incorrect responses.

The question number of each question that the student answered incorrectly is 
shown. Select the checkbox beside the questions you want to view and then 
click Show question details to see the questions.

In the question view, click Show answers to highlight the correct response. 
Click < or > to cycle through the selected questions. Click Print or Print All to 
print the questions.

For a complete list of questions and answers, refer to the Academy of MATH 
Questions Viewer, which is on the Math Skills Overview CD.

Figure 4-5:  Student training progress—Trial errors (Academy of MATH)

Question 
type

The objective of the question. The Academy of READING uses seven 
objectives:

• Main Idea/Theme
• Author’s purpose
• Detail
• Sequence

• Inference
• Vocabulary
• Relationship
• Text structure

Table 4-4: Details of errors in trials

Link Description

Select the checkboxes 
beside the questions you 
want to view.
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Progress in Individualized Training Program
Click OK to return to the Training details view.

Progress in Individualized Training Program
This page, which you access by clicking the Training program link at the top of 
the Student Training Progress page, shows how the student is progressing in 
completing the assigned Individualized Training Program. It shows the skills 
the student will be trained in, the sequence in which the skills will be 
encountered, and the progress made so far. See “Student progress from <date> 
to <date>” on page 49 for an explanation of the page.

Table 4-5: Details of errors in trials (Academy of MATH)

Link Description

Select to include this question when you click Show question details.

You can select all questions in the list by selecting the checkbox in the 
heading row.

Frequency The number of questions of this type that the student answered 
incorrectly or not at all.

Learning 
Objective

Each question in the Academy of MATH has a specific learning 
objective.

Number of 
incorrect 
responses

Gives an indication of the amount of difficulty the student had with the 
question:

1 - Student answered correctly on the second try.

2 - Student made two incorrect tries and then the program showed the 
correct answer.

Time-out - Student was unable to answer in the time allotted.

Question 
number

Use this number to locate the question in the Academy of MATH 
Questions Viewer, which is on the Math Skills Overview CD.
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The report is in two sections.

The top portion shows administrative information about the student and 
indicates which Individualized Training Program the student is following. The 
shaded portion of the page gives a summary of the student’s progress in the 
program.

The Report Details section lists all of the skills in the Individualized Training 
Program and shows how the student is progressing in each. You can select one 
of two views:

• Progress Over Time shows how long the student took to master skills and 
what criteria were used to confirm mastery (Default criteria, Academy of 
READING or Academy of MATH intervention, or Teacher intervention).

• Ease of progress gives details about how the student mastered each skill.

Figure 4-6:  Student training progress (Academy of READING/Academy of MATH)

Viewing student progress in the Individualized Training Program
The Student Training Progress shows the student’s progress in the training 
program. You open it by clicking on the ‘Training program’ name in the top 
part of the Student training progress page.

To view the student’s progress in the Individualized Training Program
1 On the Student Training Progress page, click the underlined link beside the 

Training program label. The Student Training Progress display changes to 
show the Individualized Training Program and the student’s progress.

Academy of READING

Academy of MATH
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Progress in Individualized Training Program
2 From the Report details section, select Progress over time or Ease of 
progress.

Student progress from <date> to <date>
This page shows the student’s progress in the assigned Individualized Training 
Program from the beginning of the training period to the current date. It shows 
the skills the student will be trained in, the sequence in which the skills will be 
encountered, and the progress made so far.

The information on this page is the same as presented in the Training Progress 
report on the Reports tab but it is updated as the student works, while the 
Training Progress Report is updated only at intervals specified by the System 
Administrator on the System tab.

The Summary section shows at a glance the student’s current progress.

In the Report details portion of the page, select one of the views:

• Progress over time

• Ease of progress

Table 4-6: Student progress page—Summary section

Item Description

% completed The percentage of skills in the Individualized Training Program 
completed by the student.

Total skills 
completed

In the Academy of READING, the number of skills completed but 
not necessarily mastered by the student, and the total number of 
individual skills there are in this program.

Total skills 
mastered

In the Academy of MATH, the number of skills mastered by the 
student, and the total number of individual skills there are in this 
program.

Total Time on 
Task

The total time the student has spent in training. Includes time in 
practice and training, but not time in tutorials.

Total number of 
teacher times The number of times that this student has had a teacher time event.
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Report details section—Progress over time view
This section shows all of the skills in the student’s Individualized Training 
Program, when the student worked on the skill, and the criteria that were used 
to determine that the student had mastered a skill. 

Figure 4-7:  Student training—progress over time (Academy of READING/Academy of MATH)

View Select Progress over time or Ease of progress.

Table 4-6: Student progress page—Summary section (Continued)

Item Description

Academy of READING

Academy of MATH
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Progress in Individualized Training Program
Table 4-7: Report details—Progress over time view

Field Description

Progress Indicates how the student is progressing. If the student 
has mastered the skill, the icon indicates how the student 
was progressing at the time of mastery.

Student is progressing well and has had no 
interventions for the skill.

Student has had at least one intervention in 
the skill.

Student has been paused in the skill.

Student needs teacher time.

Skill area: skill The Skill Area and the specific skill within the skill area 
that the student is working on.

Started The date that training started on this skill.

Completed The date that training was completed on this skill.
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Report details section—Ease of progress view
This section shows how the student mastered each skill, and how the student is 
progressing in the current skill. By looking at the information about each skill, 
you can see if the student is having difficulty with certain skill areas.

Mastery

Student has mastered the skill using 
Academy of READING or Academy of 
MATH default mastery criteria.

Academy
Mastered using criteria set by an automated 
Academy of READING or Academy of 
MATH intervention.

Teacher Mastered using criteria set during a Teacher 
intervention.

% and/or 
msec Criteria used to determine mastery.

Training in this Academy of MATH was 
interrupted when a staff member manually 
changed the assigned Individualized 
Training Program.

VM or AVM skill is Completed But Not 
Mastered. Because the student was having 
difficulties, the Academy had moved the 
skill to the end of the Individualized 
Training Program, but the student was still 
unable to master it.

Table 4-7: Report details—Progress over time view (Continued)

Field Description
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Progress in Individualized Training Program
Figure 4-8:  Report details—Ease of progress (Academy of READING/Academy of MATH)
Academy of READING

Academy of MATH
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Table 4-8: Ease of progress view 

Field Description

Progress Indicates how the student is progressing. If the student has 
mastered the skill, the icon indicates how the student was 
progressing at the time of mastery.

Student is progressing well and has had no 
interventions for the skill.

Student has had at least one intervention in 
the skill.

Student has been paused in the skill.

Student needs teacher time.

Skill Area: Skill

In the Academy of READING, the skill area and the 
specific skill within the skill area that the student is 
working on.

In the Academy of MATH, the skill that the student is 
working on. Shown as: Skill Area, Question Type, and 
Level.
For example, Multiplication - Operations 6.

Time on Task
The time the student has spent in training on this skill. 
Includes time in practice and training, and time viewing 
the intermediate results pages, but not time in tutorials.

Trials
The number attempts the student has made to master the 
skill. If not yet mastered, the number of attempts so far on 
the exercise.

Interventions The number of Teacher or automated AutoSkill 
interventions.

Teacher Times The number of times that this student has had a teacher 
time event while learning this skill.
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Interventions in training
Interventions in training
The Academy continuously monitors students as they progress through their 
training.

• Academy Interventions: If students are having difficulties, or are per-
forming particularly well in certain skills, the program will intervene. Inter-
ventions are designed to help the students through the difficulties or, for 
students who have mastered a skill early, promote them to the next skill.

• Teacher Time: Teacher time is an intervention by the program that pauses 
a student’s training so that the teacher can investigate.

• Teacher Interventions: There is also the possibility for Teachers to inter-
vene to change mastery criteria for individual skills or for entire skill areas. 
See “Modifying mastery criteria” on page 57 for information about chang-
ing mastery criteria. Normally, this type of intervention should be taken 
only after considerable thought. These are referred to in student training 
progress views and in reports as Teacher interventions.

Academy interventions
Academy of READING and Academy of MATH interventions can consist of:

• Accelerated mastery: If a student performs an exercise with no errors, the 
Academy of READING or the Academy of MATH intervenes and tells the 
student that he or she has mastered the exercise. In a puzzle gallery, any 
remaining puzzles will be replaced with the Accelerated Mastery picture as 
shown 
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Figure 4-9: Accelerated Mastery (Academy of READING/Academy of MATH)

• View tutorial and practice: Normally, one of the first interventions is to 
pause training and have the student view the tutorial and practice the skill.

• Change mastery criteria: A temporary change in mastery criteria can 
help a student over an isolated problem area and to experience success. The 
changed criteria can be seen in training progress pages.

• Pause current exercise and assign another: In Academy of READING 
Visual Match and Auditory-Visual Match exercises, the program can inter-
vene to give the student a break from the current exercise and assign an 
exercise from another skill area. Upon completion of that skill, the student 
will return to the paused skill.
In the Academy of MATH, the program can intervene to assign a puzzle 
from the previous level of the skill as a review and a break. The review 
skill is also inserted into the Training Progress Report for the student. After 
completing the review, the student returns to the original level.

Teacher time
If the automatic interventions are not successful, the student’s training is 
paused and the student sees a teacher time picture. The teacher is required to 
assess the situation and give individual assistance before permitting the student 
to continue.

In the Academy of MATH, the student can also be placed in Teacher Time if the 
results of the math placement test are significantly below what would be 
expected given the student’s grade. The teacher can accept the suggested 
Individualized Training Program or assign a different one.
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Modifying mastery criteria
Figure 4-10:  Teacher Time

When the student is ready to resume training, the teacher can clear the teacher 
time from the Student training progress page or from the student’s workstation.

To clear teacher time
1 On the Student Training Progress page, click Clear teacher time.

or
From the student’s workstation, click Go to teacher page, enter the 
teacher’s user name and password, and then click Clear teacher time.

Modifying mastery criteria
In exceptional circumstances, it may be necessary for a teacher to modify the 
criteria for a single skill or even an entire skill area.

If a student is having difficulty in a single skill, and the automatic interventions 
by the Academy have not solved the problem, the teacher can lower the criteria 
for that single skill to allow the student to move on. This would be done to 
prevent frustration reaching unacceptable levels. By moving on, the student 
would likely do better on the skill the next time it appeared.

If a student would benefit from training in the AutoSkill Academy Suite, but is 
unlikely to succeed with the normal criteria, it is possible to change the 
mastery criteria for an entire skill area. In the Academy of MATH, it is also 
possible to change the mastery criteria for a student’s entire Individualized 
Training Program. After the mastery criteria are modified, the student 
completes training using the altered criteria throughout. Changing mastery 
criteria for an entire skill area or training program should be used only after 
careful planning because of the risk of reducing the effectiveness of the 
training.
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Mastery criteria for the current skill
When you modify the mastery criteria for the current skill, you override the 
criteria set by the Academy for the skill that the student is currently working 
on. In the Academy of MATH, the change applies to the current level only.

Click the underlined Modify Mastery Criteria for <the Current Skill> link on 
the Student Training Progress page.

The criteria are applied to the next trial the student attempts for the skill.

To modify the mastery criteria for the current skill
1 On the Student Training Progress page, click the underlined link Modify 

mastery criteria for <the current skill>. The Modify Mastery Criteria for 
<the Current Skill> page appears.

2 Modify the criteria as shown in .
3 Click Apply to current skill.

Modify mastery criteria for the current skill
This page displays the criteria that the current student must satisfy in order to 
progress in the skill being worked on.

You would normally consider modifying the criteria for the current skill if a 
student was having difficulty on an exercise; for example, was in teacher time 
and you want to provide assistance in getting over an isolated obstacle.

Changes take effect on the next trial the student starts.
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Figure 4-11:  Modify mastery criteria for the current skill

Click Apply to current skill to apply the changes you have made to all 
exercises in the current skill.

Table 4-9: Modify mastery criteria for the current skill 

Field Description

Current status The shaded area of the page shows the changes that were last made 
to the mastery criteria and the role of the person that made them.

Modify 
mastery 
criteria for...

Depending on the skill, changes can be made to:

• Puzzle size (Applies to all puzzles in the Academy of MATH, 
and to SM and LSM only in the Academy of READING).

• Accuracy.
• Question timeout length (Applies to SM and LSM in the 

Academy of READING and to all puzzles in the Academy of 
MATH).

• Response time range (VM and AVM only).

Titles indicate that the criteria 
are for the current skill only

Academy of READING

Academy of MATH

Applies only to this level
  59



Chapter 4: Monitoring and Managing Student Training
Click Reset to recommended to reset the criteria to those recommended by 
the Academy of READING or the Academy of MATH.

Click Cancel to return to the previous page without saving any changes.

Mastery criteria for an entire skill area
When you modify the mastery criteria for an entire skill area, you over-ride the 
criteria set by the Academy of READING or the Academy of MATH for all 
exercises in the skill area. This is much broader than simply changing the 
criteria for a single skill. In the Academy of MATH, the changes apply to all 
levels in the student’s Individualized Training Program.

On the Student training progress page, you click the underlined Modify 
mastery criteria for an entire skill area link (which is only available for 
students who have started training). You select the skill area or Academy of 
MATH question type (Terms, Operations, Word Problems, or All), and then 
change the criteria. In the Academy of MATH, you can also choose to modify 
all of the skill areas at the same time.

Note: Changes take effect with the next exercise that is assigned. If the stu-
dent is ready for a new exercise but has not yet begun it, the criteria for 
the exercise have already been set. That exercise will use the old criteria.

To modify the mastery criteria for an entire skill area
1 On the Student Training Progress page, click the underlined link Modify 

mastery criteria for an entire skill area. The Modify Mastery Criteria for 
a Skill Area Page appears.

2 Academy of READING: Click on the skill area to be modified. The Mod-
ify Mastery Criteria for the Selected Skill Area page appears.

3 Academy of READING: Modify the criteria and then click Apply to skill 
area. The display returns to the Modify Mastery Criteria for a Skill Area 
page.

4 Academy of MATH: From the Question type drop-down list, select the 
type of entries to appear in the Questions type column.

5 Academy of MATH: You can choose to modify all of the question types for 
a skill area on a single page, modify only a single question type for a skill 
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area, or you can choose to modify the question types for all of the skill 
areas in the entire training program.
• To show all of the question types in a skill area, click on the skill area in 

the Skill area column. The Modify Mastery Criteria for the Selected 
Skill Area page appears. Modify the criteria for each question type to be 
changed and then click Apply. When all changes have been applied, 
click OK. The display returns to the Modify Mastery Criteria for a Skill 
Area page.

• To show only a single question type, click on it in the Question type 
column. The Modify Mastery Criteria For All Levels of a Single Math 
Skill page appears. Modify the criteria and then click Apply to skill 
type. The display returns to the Modify Mastery Criteria for a Skill Area 
page.

• To modify all of the skill areas at the same time, click on Modify the 
entire training program. The Modify Mastery Criteria for the Entire 
Math Training Program page appears. Modify the criteria for each ques-
tion type to be changed and then click Apply. When all changes have 
been applied, click OK. The display returns to the Modify Mastery Cri-
teria for a Skill Area page.

6 Select another skill area or to finish, click OK.

Modify mastery criteria for a skill area
This page lists the skill areas that can be included in a student’s Training 
Program. Skill areas that are included in the selected student’s Training 
Program are underlined and shown in a different color. You can click on the 
skill area to modify the mastery criteria for all of the reading skills or math 
question types that comprise it, or in the Academy of MATH you can choose to 
modify the criteria for a single question type and leave the criteria for the 
others unchanged.
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Figure 4-12:  Modify mastery criteria for a skill area

Table 4-10: Modify mastery criteria for the skill area

Field Description

Skill area
Skill areas that are included in the selected student’s Individualized 
Training Program are underlined and shown in a different color. 
You can click on the skill area to modify the mastery criteria for all 
of the skills that comprise it.

Last modified If the criteria for the skill have been modified, shows the date on 
which a user last modified the criteria.

Academy of MATH

Academy of READING

Select the entries to 
appear in Question 
type column

Click a Skill 
area to modify 
its criteria

Click a Question type 
to modify criteria for 
just one Question 
type in the skill area

Click a Skill area to 
modify criteria for all 
Question types in the 
skill area
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Click OK to return to the previous page.

Modify mastery criteria for the selected skill area
This page allows you to change the criteria for the entire skill area selected in 
the Modify mastery criteria for the skill area page. Changes will apply to all 
exercises in the skill area, not just to the specific skill being worked on. You 
can change the criteria or reset them to the settings recommended by the 
Academy of READING or the Academy of MATH.

Before you modify mastery criteria, you should be sure that this is the best way 
to address the student’s problem.

Modification 
type

Academy recommended: The last change made was to return the 
settings to those recommended by the Academy of READING or the 
Academy of MATH.

Teacher modified: A user modified the criteria to something 
different from the settings recommended by the Academy of 
READING or the Academy of MATH.

Complete A check mark indicates that the student has completed training in 
this skill area.

Table 4-10: Modify mastery criteria for the skill area

Field Description
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Figure 4-13:  Modify mastery criteria for <entire skill area>

Table 4-11: Modify mastery criteria for skill area <entire skill area>

Field Description

Current status The shaded area of the page shows the changes that were last made 
to the mastery criteria and the role of the person that made them.

Criteria

Depending on the skill, changes can be made to:

• Puzzle size (Applies to all puzzles in the Academy of MATH, and 
to SM and LSM only in the Academy of READING).

• Accuracy.
• Question timeout length (Applies to SM and LSM in the 

Academy of READING and to all puzzles in the Academy of 
MATH).

• Response time range (VM and AVM only).

Titles indicates that 
the criteria are for 
the entire skill area

Academy of READING

Academy of MATH
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Academy of READING—Click Apply to skill area to use the new mastery 
criteria for all remaining exercises in the Academy of READING skill area. 
Click Cancel to cancel the changes and return to the previous page.

Academy of MATH—Click Apply beside each skill area that you are changing. 
After you have applied all your changes, click OK to return to the previous 
page. The new mastery criteria will be used for all remaining exercises in the 
Academy of MATH skill area.

Click Reset to recommended to reset the mastery criteria to the criteria 
recommended by the Academy of READING or the Academy of MATH.

Modify mastery criteria for all levels of a single Math skill
This page displays the criteria that the current student must satisfy in order to 
progress in this Math skill. Changes made here apply to all levels in the 
student’s Individualized Training Program.

Changes take effect on the next trial the student starts.

Figure 4-14:  Modify mastery criteria for all levels of a Math skill

Table 4-12: Modify mastery criteria for all levels of a Math skill 

Field Description

Current status The shaded area of the page shows the changes that were last made 
to the mastery criteria and the role of the person that made them.

The absence of a Level in the 
Title indicates that the changes 
apply to all levels
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Click Apply to current skill to apply the changes you have made to all 
exercises in the current skill.

Click Reset to recommended to reset the criteria to those recommended by 
the Academy of MATH.

Click Cancel to return to the Student training progress page without saving 
any changes.

Modify mastery criteria for the entire Math training program
This page allows you to change the criteria for the selected skill types in all 
skill areas in the student’s Individualized Training Program in the Academy of 
MATH. You can change the criteria or reset them to the settings recommended 
by the Academy of MATH.

Before you modify mastery criteria, you should be sure that this is the best way 
to address the student’s problem.

Criteria

Depending on the skill, changes can be made to:

• Puzzle size (Applies to all puzzles in the Academy of MATH, 
and to SM and LSM only in the Academy of READING).

• Accuracy
• Question timeout length (Applies to SM and LSM in the 

Academy of READING and to all puzzles in the Academy of 
MATH).

• Response time range (VM and AVM only).

Table 4-12: Modify mastery criteria for all levels of a Math skill  (Continued)

Field Description
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Modifying the assigned training program
Note: Changes take effect with the next exercise that is assigned. If the stu-
dent is ready for a new exercise but has not yet begun it, the criteria for 
the exercise have already been set. That exercise will use the old criteria.

Figure 4-15:  Modify mastery criteria for entire math training program

Click Apply beside each skill area that you are changing. After you have 
applied all your changes, click OK to return to the previous page. The new 
mastery criteria will be used for all remaining exercises in the Academy of 
MATH.

Modifying the assigned training program
In the Academy of MATH only, after a student has done some training, it may 
become apparent that the student would benefit from training at a different 
level than the one assigned. If the license permits, a staff member can change 
the training program. A link is provided on the Student Training Progress page. 

Table 4-13: Modify mastery criteria for entire math training program

Field Description

Criteria

Changes can be made to:

• Puzzle size
• Accuracy 
• Question timeout length

Title indicates that the criteria are for the 
entire training program

You can change each 
question type individually
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Figure 4-16:  Modify the individualized training program

To modify the individualized training program
1 On the Student Training Progress page, click the underlined link Modify 

the Individualized Training Program. The Modify the Individualized 
Training Program page appears.

2 Select a program from the drop-down list.
3 Click Switch to new training program.

The student is logged out and the new program is assigned to the student. 
Any skills in the new program that the student has previously mastered at 
Academy default criteria are removed. Any skills from the old program that 
were mastered at other than Academy default criteria are added to the new 
program.
Information about the original program remain available in the Student 
Training Progress report.

Certificates
The Academy of READING and the Academy of MATH award certificates to 
students at frequent intervals for mastering skills. The students can look at 
them in the Trophy Case and they can print each certificate up to three times.

On the Classes tab, teachers can see which certificates have been awarded and 
which ones have been printed. They can also print copies (as many as needed).
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Certificates
Figure 4-17:  Class certificates page

Listing and printing certificates earned by a class
The Certificates menu on the Classes tab provides access to the student 
certificates.

To list the certificates earned by a class
1 Click on the Classes tab and then click Certificates. The Class Certificates 

page appears.
2 Select Academy of READING or Academy of MATH from the drop-down 

list.
3 Select a School from the list. System Administrators can select a school. 

AutoSkill Coordinators and Teachers can see only their own school.
4 Select a Class from the list. System Administrators and AutoSkill Coordi-

nators can select any class in the school. Teachers can select only their own 
classes.

5 To show only certificates awarded during a specific period, select a new 
‘from’ date and a ‘to’ date and then click Show.

6 Select the students whose certificates are to be printed.

Click Show to update the 
list when you change the 
date selections

Select Reading or 
Math

Click to print all certificates 
earned by the selected students

Click to print certificates that 
haven’t been printed yet.
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7 To print all of the certificates earned by the selected students, click Print 
total earned.
To print only the certificates that have not yet been printed, click Print 
only certificates not yet printed.

Note: To print specific certificates for an individual student, see “List-
ing and printing student certificates” on page 71.

Class certificates
Shows the number of certificates earned by students in a class during a period 
you specify. It shows the date each student last earned a certificate, the total 
number earned, and the number that have been not yet been printed.

Select a School from the list. System Administrators can select a school. 
AutoSkill Coordinators and Teachers can see only their own school.

Select a Class from the list. System Administrators and AutoSkill Coordinators 
can select any class in the school. Teachers can select only their own classes.

In the Show the certificates earned area, enter the dates for the period in which 
you want certificates shown, and then click Show.

Initially, the dates are for the start and finish of the school training period.
The earliest start date is the beginning of the training period. The latest end 
date is the end of the training period.

Table 4-14: Class certificates 

Field Description

Select to include this student’s certificates when you click either 
print button.

You can select all students in the list by selecting the checkbox in 
the heading row.

Student name Click to open the Certificates Earned page for the student.

Grade The grade the student is in.

Last received The date the student last earned a certificate.

Total earned The total number of certificates the student has earned.
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Click Print total earned to print all certificates earned by the selected 
students, including those that have already been printed.

Click Print only certificates not yet printed to print only the certificates that 
have not yet been printed for the selected students.

To print additional copies of certificates that have already been printed, click 
on the student’s name to open the Certificates Earned page, and select the 
certificates to be printed.

Listing and printing student certificates
The Student Certificates page shows a history of the certificates that a student 
has earned. You can select and print any or all of the certificates.

Figure 4-18:  Student certificates page

Not yet printed
The number of certificates that have not yet been printed for each 
student. Each student can print up to three copies of each 
certificate. However, staff members can print more.

Table 4-14: Class certificates  (Continued)

Field Description

Academy of READING

Academy of MATH
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To list and print the certificates earned by a student
1 On the Class Certificates page, click on a student name. The Student Certif-

icates page appears.
2 Select the certificates to be printed and then click Print.
3 Click Cancel to return to the previous page.

Student certificates
Lists the certificates that the selected student has earned. You can select some 
or all of the certificates and print them.

For each skill area, the page lists the skills in which the student has earned 
certificates, the date on which each certificate was earned, and how many 
copies have been printed.

Click Print to print a copy of each of the certificates that has a check mark 
beside it.

Click Cancel to return to the previous page.

Table 4-15: Certificates earned 

Field Description

Select to include this certificate for printing.

You can select all certificates in the list by selecting the checkbox in 
the heading row.

Skill area Skill areas in which the student has earned certificates.

Skill Within each skill area, the specific skill for which a certificate has 
been earned.

Earned on The date on which the student satisfied the criteria for earning the 
certificate.

Printed
The number of copies of the certificate that have been printed. Each 
student can print up to three copies of each certificate. However, staff 
members can print more.
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Student Testing
The Class Test Schedule page shows the tests that students have completed, the 
date of the next scheduled test in the class, and the scheduled dates of the next 
test for each student in the class. If the next scheduled test in the class is within 
seven days, a yellow triangle appears next to the date and the date turns into a 
link to the “Best practices for testing” on page 74.

Unless the teacher specifies that a student is not to be tested, all students 
(except for Kindergarten and Grade One students in the Academy of 
READING) are assigned a placement test when they first click on the 
classroom door to determine the Individualized Training Program that they 
will follow.

In the Academy of MATH, if the results of the placement test are significantly 
below what would be expected given the student’s grade, the teacher can 
accept the suggested Individualized Training Program or assign a different 
one.

After a students completes a post-test, the program does not automatically 
schedule additional tests but you can schedule them if you wish. The date of 
the last test taken is always shown on the Class Test Schedule page. You can 
assign dates for post-tests for any or all students.

Students receive scheduled tests the first time they log in on or after the 
scheduled date.

Figure 4-19:  Class test schedule

Select Reading or 
Math

When test is near, icon appears 
and date becomes a link to show 
Best Practices for Testing
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Best practices for testing
Students who are mentally prepared do better in tests:

• Try not to test at the end of a day or week or when students are tired. Test-
ing near holidays or other fun activities can result in weak attention to the 
task and results in poor outcomes.

• Students need to be in a good frame of mind. If students are having a bad 
day, their scores will reflect this.

For all tests:

• Allow at least a full class period for the test. Some students will require 
more than one period. Tell the students that the test may take some time.

• During the test, monitor students early to ensure they understand and are 
participating. Tell them not to rush. Time is not a factor; however, you 
should note the time that each student takes. Watch for students who are 
going through the assessment too quickly.

• Some younger students may not understand how to use the mouse at first. 
You will have to show them.

• Have students check their work, ensuring that they did not miss any ques-
tions.

For post-tests:

• A post-test requires the same student preparation as the pre-test.

• The Class Training Monitor page show the next date that a test is scheduled 
in the class.

• Students should not start a post-test on the same day that they do other 
training in the program. Have them begin the test the next day they are in 
class.

• Ensure that students know that this assessment will show them how they 
have improved and that they need to do the best that they can.

• If a student seems to be rushing through the test, look at their pre-test times 
for guidance. If appropriate, remind the student how much time they took 
on the pre-test.

In the Academy of READING:
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• Have students read the entire passage silently before answering any ques-
tions. More than one response may appear to be usable, so tell the student 
to select the response that they think most closely fits the story.

• The I'm Done button appears when the student has completed a story. If the 
button does not appear, the student has probably not answered all of the 
questions. Look for empty blanks in the story.

In the Academy of MATH

• Tell the student not to worry if the questions appear too difficult. In order to 
find the correct level, the program must ask questions that are beyond the 
student's ability.

• The I'm Done button appears when the student has answered all ten of the 
questions in the current level. If the button does not appear, the student has 
probably not answered all of the questions. Look for a 'blue button' in the 
list of question numbers.

Scheduling tests
The dates that tests were completed and post-tests are scheduled are shown on 
the Class Test Schedule page. You can select one or more students and change 
the dates for the next post-test.

To change scheduled test dates
1 Click on the Classes tab and then click Test schedules. The Class Test 

Schedule page appears.
2 Select Academy of READING or Academy of MATH from the drop-down 

list.
3 Select a School from the list. System Administrators can select a school. 

AutoSkill Coordinators and Teachers can see only their own school.
4 Select a Class from the list. System Administrators and AutoSkill Coordi-

nators can select any class in the school. Teachers can select only their own 
classes.

5 Select the checkbox beside one or more students.
6 In the Select a new post-test date area below the students list, select the 

date for the test.
7 Click Apply new date. The new date is entered in the Next test scheduled 

column for the selected students.
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Class test schedule
This page shows when students in the selected class took their placement test, 
and when additional tests are scheduled. If a student has already taken a test, 
the date on which the test was taken is shown. On this page, you can change 
the scheduled date for one or more students.
The date of the next scheduled test in the class is shown. If the date is near, the 
label turns into a link that you can click to view a list of best practices for 
preparing students for a test.

In the Select a new post-test date area at the bottom of the page, select the 
new test date to be applied to the selected students.
Click Apply new date to apply the new date to the students who have a check 
mark beside their names.

Click Cancel post-test to remove the scheduled post-test from the students 
who have a check mark beside their names.

Table 4-16: Student tests

Field Description

Select to include this student when you reschedule or cancel a post-
test.
You can select all students in the list by selecting the checkbox in 
the heading row.
Students in Kindergarten or grade 1 are not tested, so they do not 
have test dates.

Student name Lists the students in the selected class.

Grade The grade the student is in.

Placement test 
taken The date that the student completed the placement test.

Next test 
scheduled

The date that the student is to take test. If the entry is blank, the 
student is not scheduled to have a test.

Latest test 
taken The date that the student last completed a test.
76



Student finishes a training program
Student finishes a training program
Upon completing the assigned Individualized Training Program in the 
Academy of READING or the Academy of MATH, most students will be 
assigned additional material. They will see a message in the classroom 
congratulating them on all the hard work that they have done and telling them 
that they may have some review or bonus activities to complete.

Upon clicking Continue, students are taken to the Lobby. They click the 
classroom door to begin work on the review and bonus activities. If there are 
none, they have completed training and will see a congratulatory message.

Figure 4-20:  Individualized Training Program completed

Notes: For students who have completed their initial training program, 

symbols on the Student Training Progress page and on student reports 

will indicate that the student is working on additional material.

• An asterisk (*) in front of the training program name indicates that 
the student has completed the initial Individualized Training Pro-
gram and is working on additional material. Also, in the Academy of 
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MATH only, the asterisk will appear if a teacher has manually 
changed the student’s assigned Individualized Training Program.

• A plus-sign (+) after the training program name indicates that some 
skills from the previous training program were not mastered at the 
Academy Recommended criteria and have been added to the current 
training program.

• A period followed by a number (for example, “.2”) after the training 
program name indicates that the same training program has been 
assigned previously in the current training period or in a previous 
training period.

Additional Academy of READING training
When a student completes the Individualized Training Program in the 
Academy of READING, the program automatically assigns the next higher 
training program as continuation training plus any skills not mastered at the 
default criteria in the originally assigned training program. Any exercises in 
the new training program that the student has already mastered using the 
Academy of READING default criteria are removed from the new training 
program.

Students in the 8-Adult Accelerated reading program are assigned only those 
skills that were not mastered at the default criteria. Students in this program 
who have completed all skills at the default criteria are not assigned any new 
activities. They have completed their training.

Additional Academy of MATH training
When a student completes an Individualized Training Program in the Academy 
of MATH, the program automatically assigns the next higher training program 
to the student, plus any skills from the just-completed program that were not 
mastered at the default criteria. Any exercises in the new training program that 
the student has already mastered using the Academy of MATH default criteria 
are removed from the new training program.

Students who have completed Level 8 are assigned only those skills that were 
not mastered at the default criteria. Students at this level who have completed 
all skills at the default criteria are not assigned any new activities. They have 
completed their training.
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User roles
In this chapter:

• Introduction

• System Administrator

• District Administrator

• AutoSkill Coordinator

• School Administrator

• Teacher

• Student
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Introduction
Users can take on any of six roles. The first five are for staff users, who 
manage the Academy or view reports about student training

• System Administrator

• District Administrator

• AutoSkill Coordinator

• School Administrator

• Teacher

• Student

System Administrator
System Administrators are responsible for tasks that affect all schools in the 
district. Tasks include:
• Adding or removing schools
• Importing, exporting, and transferring students
• Setting system options
• Setting report update schedules
• Managing the database

System Administrators can also carry out the tasks of any other user in any 
school. System Administrators who have responsibilities for database and 
system maintenance should also understand the technical aspect of the 
Academy installation.

Table 5-1: System Administrator privileges

Can access May add May delete May modify 
information on

System tab
Schools tab
Classes tab
Users tab
Reports tab

All user types in 
any school.

All users in any 
school. May not 
delete self.

All users in any 
school.
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District Administrator
District Administrators are educational and administrative personnel, such as 
District Supervisors or Academy Project Managers, who need to view reports 
from all schools in the district.
The District Administrator’s main roles are to monitor usage and to ensure that 
the implementation is going well. They have no management functions within 
the Academy.

AutoSkill Coordinator
The primary roles of the AutoSkill Coordinator are to help set up the school, 
make it ready for training, and to ensure that the Academy runs smoothly 
throughout the year. This user can act as the Academy representative or project 
manager in a school. The AutoSkill Coordinator can carry out some of the 
basic system administration functions and can stand in if the System 
Administrator is unavailable.

AutoSkill Coordinators are responsible for coordinating Academy activities in 
a single school. They manage:

• User accounts

• Classes

• Student training

• Reporting

Table 5-2: District Administrator user management privileges

Can access May add May delete May modify 
information on

Reports tab Cannot view or modify information about other users.
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School Administrator
School Administrators are educational and administrative personnel, such as 
Principals or Vice-Principals, who need to view reports for their school. They 
have no management functions within the Academy.

Teacher
Teachers are responsible for managing training for the students in their classes. 
Each teacher works in a single school only. Tasks include:

• Creating classes

• Assigning students to classes

• Monitoring, assisting, and managing their students’ training

The System Administrator sets an option on the System tab to control whether 
teachers can add or delete student users.

Table 5-3: AutoSkill Coordinator privileges

Can access May add May delete May modify 
information on

System tab
Schools tab
Classes tab
Users tab
Reports tab

AutoSkill Coord, 
SchAdmin, 
Teacher, Student in 
their own school 
only.

In their own school: 
AutoSkillCoord, 
SchAdmin, 
Teacher, Student. 
May not delete 
themself.

AutoSkillCoord, 
SchAdmin, 
Teacher, Student in 
their own school 
only.

Table 5-4: School Administrator privileges

Can access: May add: May delete: May modify 
information on:

Reports tab Cannot view or modify information about other users.
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Student
This is the role assigned to people who are taking training in the Academy. 
Each Student can be assigned to one school only.

Table 5-5: Teacher privileges

Can access May add May delete May modify 
information on

Classes tab
Reports tab

Student (Basic 
information only; 
cannot add 
demographic 
information).

Students, in their 
own classes only.

Student (Basic 
information only; 
cannot see, add, or 
change 
demographic 
information).

Table 5-6: Student privileges

Can access May add May delete May modify 
information on

Student User 
Interface only Students do not have any management functions.
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